
Workshop Topic 
Graphics in 2D and 3D

This workshop topic will cover 2D 
graphics such and hatches, gradients 
and images and 3D graphics such as 
textures and image props. 

Q & A 
How can I use my  iPod as a 
presentation device?

Following on from last month, I got 
the cable I need to connect my iPod 
to a TV and it’s now very easy to use 
your iPod as a presentation device.  

Can I Re-Use my VectorWorks 
12 Wall style Library for 
VectorWorks 2008?

The answer is well, yes and no. I 
need to explain my thinking...

Extended Podcast 048

Should you use layer linking or 
design layer viewports? Watch this 
podcast to see more. 

Extended Podcast 049

Plants are designed to behave differ-
ently in VectorWorks 2008. Watch 
this podcast to see more. 

 

c a d s u p p o r t o n l i n e . c o m  issue 0711

This newsletter is designed to work as an on-line user group. It is based on the successful New Zealand VectorWorks User 
Group format, where each month we cover a main topic in a workshop then have a page of general questions and answers. 
In this news letter you will find a link to the workshop topic, a link to the questions and answers and links to extended 
podcasts (tips and trick movies). 

http://learn.archoncad.com/?p=1516
Extended Podcast 049


©Jonathan Pickup	 cadsupportonline  - Issue 0711

Page 2

•	 Use the Attributes 
Palette to change 
the line weight to 
a heavy line.

•	 The ground line 
has a heavy line.

•	 Select the building 
outlines.

•	 Set the line weight to a 
medium line weight.

•	 You can see the 
building outlines.

2D Graphics 

Graphic Attributes
cadmovie094

The file we’ll be using is an elevation of a building. We will use this 
to learn how to apply graphic attributes, such as line weight, hatching, 
image fills and graphic symbols to a drawing.

•	 Open a Vectorworks 
file. 

•	 Use the 2D Selection 
tool to select the 
ground line.

G r a p h i c s  f o r  2 D  a n d  3 D

http://learn.archoncad.com/?p=1522
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Hatches
cadmovie095

Applying Hatches

•	 Select the base of the building.
•	 You can apply a hatch to this part of the build in several ways.
•	 You can use the Attributes Palette to select the hatch.
•	 You can use the Resource Browser to find a hatch and then 

either double click on the hatch in the Resource Browser 
or drag the hatch to the object that you want to hatch.

•	 None of these options allows you to control 
the start point of the hatch. 

•	 From the menu bar choose 
Modify > Hatch...

•	 From here you can choose a default 
hatch or you can make a new hatch.

•	 Click on the New... button. 

•	 Select the 
building entry.

•	 Set the line weight 
to a medium-heavy 
line weight.

•	 You can see the 
building entry is 
now emphasised.

•	 Next we will add 
brick hatching to the 
base of the building. 

http://learn.archoncad.com/?p=1528
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Creating Hatches
To create a new hatch pattern, first decide what the hatch should look 
like.  

For this example we will make a brick hatch 300x100mm (12”x4”)  
stretcher bond.    We have to look for lines that repeat, and often I will 
sketch out the hatch pattern so that I can work out where the lines repeat.  

•	 If you look at the figure to 
the right you will see that 
I have worked out that we 
need 3 lines, or 3 layers to 
use the naming conventions 
that VectorWorks uses.  

Step 1

•	 Now you see the 
Edit Hatch Dialog.

•	 Name the hatch 
300x100mm Brick 
(12x4 in. Brick).

•	 Change the Units to  
World Units.

•	 Set the Start point 
to be 0,0.

•	 Set the repeat to be  
300mm  @ 0º 
(12” @ 0º).

•	 Set the Offset to be  
100mm @ 90º 
(4” @ 90º).

 Step 2  

•	 Click on the Add 
Level button. 

•	 When it creates the 
new line (level) it’s 
at the wrong angle.  
VectorWorks will not let 
you have both the offset 
and the repeat at 0º.

•	 Change the Offset 
angle to 45º.

•	 Then you can change 
the Repeat angle to 90º.  

•	 Set the start point to 0,0.
•	 Set the repeat to be  

200mm @ 90º  
(8” @90º).

•	 Set the dash factor to 
0.5.  We will end up 
with a repeating line 
200mm long that skips 
a tile course of 100mm.

•	 Set the Offset to be  
300mm @ 0º  
(12” @ 0º).
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 Step 3

•	 Click on the Add 
Level button. 

•	 It should repeat the 
first tile course.  

•	 Set the start point to 
150,100mm (6”, 4”).

•	 When you are happy 
click on the  OK 
button.  You are 
finished, nearly...

Step 4

•	 The hatch is now selected in the 
Select Hatch dialog box. 

•	 Click on the OK button.

•	 Zoom into the base 
of the building.

•	 Click at the bottom left 
corner of the building. 
This sets the insertion 
point of the hatch.

•	 Move along the 
ground line.

•	 Click once. This finishes 
the hatch placement.

•	 The windows are 
behind the hatch. 

•	 Use the 2D 
Selection tool.

•	 Drag marque around 
the windows.

•	 From the Menu Bar 
choose 
Modify > Send > 
Send to Front.

•	 Now the windows are visible. 
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•	 If there are other 
windows that are 
behind the hatch, do the 
same for them, bring 
them to the front. 

•	 Drag the concrete 
hatch from the 
Resource Browser 
to the ground line. 

•	 This is quick, but 
you can’t control the 
insertion point of 
the hatch. Great for 
this type of hatch.

    

Images
Images are a great way of applying a graphic image to your drawings. 

cadmovie096

Applying Images

•	 In the Resource Browser you will find 
an image of bricks. If you can’t see the 
bricks, make sure that your Resource 
Browser is pointing to the current file. 

•	 Drag the brick image 
from the Resource 
Browser to the right 
end of the building. 

•	 When you let go of 
the mouse the image is 
applied to the elevation.

http://learn.archoncad.com/?p=1530
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Creating Images

•	 To create a new image, go to 
the Resource Browser.

•	 Right mouse click in the Image area of the 
Resource Browser. It doesn’t matter if you 
right mouse click on an existing image.

•	 Choose New Image in...
•	 Choose the option to import an image 

file. You can use this option to make 
an image from an existing resource, 
like a texture for example. 

•	 Find the Cladding.psd image 
in the exercise folder. 

•	 Click on the Open button. 

•	 Choose your compression 
options if they appear. If they don’t 
appear do not worry about it. 

•	 To edit the image, use the 
Attribute/Mapping tool.

•	 Click on the brick 
elevation. You will 
see a rectangle appear. 
This is used for 
editing the image...

•	 If you go the top right 
corner you can drag 
your mouse to change 
the size of the bricks.

•	 If you go to the middle 
of the rectangle you 
can drag the start of 
the brick around.



©Jonathan Pickup	 cadsupportonline  - Issue 0711

Page 8

•	 The new image appears in 
the Resource Browser.

•	 Click on the image in the Resource Browser. 

•	 Drag your mouse 
to the building

•	 When you let go of 
the mouse button 
the image is applied 
to the building. 

•	 Edit the image on the 
elevation using the  
Attribute/
Mapping tool.

Gradients
cadmovie097

Gradients are a great way of adding  colour fill where you want the colour 
to change from one colour to another (or several colours). 

Applying Gradients

•	 Select the Sky gradient in the 
Resource Browser.

•	 Drag the sky gradient 
to the background 
behind the building. 
It hard to see, but just 
let go of the mouse.

•	 When you choose the 
Attribute/Mapping 
tool, you see a line. 
This line defines 
the length and angle 
of the gradient

•	 Click on the left 
end of the line.

•	 Move to the 
ground line.

http://learn.archoncad.com/?p=1532
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•	 Click once.
•	 Click on the right 

end of the line.
•	 Move vertically up 

from the road.
•	 Click once.

Creating Gradients

•	 To create a new gradient, go to 
the Resource Browser.

•	 Right mouse click in the Gradient area of 
the Resource Browser. It doesn’t matter if 
you right mouse click on an existing image.

•	 Choose New Gradient in filename...

•	 When the dialog box opens it 
shows a default name.   Remember 
to give the gradient a name that 
will be meaningful.  We will be 
making this one from white on 
the left to blue on the right.  

•	 At the top where it says name, 
type in Glass Doors.

•	 The colours are controlled by the slider at 
the bottom of the gradient line.  

•	 Double click on the black slider.
•	 Choose the colour blue you want, then click on 

the OK button to close the colour palette.

•	 The slider at the top of the gradient 
line is used to control the mid-point 
of the gradient.  You can slide this 
left or right to change the gradient.

•	 Click on the OK button.

•	 When you close the Gradient Editor 
VectorWorks adds the new gradient 
to your Resource Browser.

•	 Zoom into the 
entry doors.

•	 Use the Resource 
Browser to add 
the glass door 
gradient to the glass 
above the doors.

•	 Use the Resource 
Browser to 
add the glass 
door gradient to the doors.



©Jonathan Pickup	 cadsupportonline  - Issue 0711

Page 10

Object Opacity
cadmovie098

Object opacity is the ability to make an object transparent. For an eleva-
tion like this we could draw shadows for the building and make them 
transparent. 

•	 This is the elevation as 
we have been drawing.

•	 Draw two rectangles 
for the shadow.

•	 Select them both.
•	 Right mouse click.
•	 Choose Add Surface.

•	 Use the Attributes 
Palette to give 
the polygon a 
solid black fill.

•	 Back to the Attributes 
Palette and click on 
the Opacity button, 
where it says 100%.

 

•	 Change the opacity to 40%.
•	 Click on the OK button. 

•	 Now you can see 
transparent shadows. 
You can apply different 
opacity to individual 
objects, so if you want 
some shadows to be 
darker than others 
you can do this...

Line Styles
cadmovie099

VectorWorks 2008 has a new linestlye editor that makes it easier to create 
your own dashed line styles. 

http://learn.archoncad.com/?p=1536
http://learn.archoncad.com/?p=1538
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Lighting

Lighting is a really important part of rendering, without good lighting a 
rendered model can look dull. 

Good lighting can save a dull model!

The are two types of lighting:

	 •  Ambient Lighting

	 •  Light Sources

Layer Lighting Options

cadmovie100

The Layer Lighting Options control the ambient lighting is the lighting 
all around, it has no direction and therefore casts no shadows. The real 
world equivalent is the southern sky, also know as the sky dome.

•	 Change to the Lighting layer.
•	 To set ambient lighting, 

from the Menu Bar choose 
Views > Lighting > Set Layer 
Lighting Otions... 

•	 This opens a dialog box for you to 
set the level of ambient lighting. 
Usually 30-40% is about right. 

•	 Ambient lighting on it’s own is 
not good enough. We also need to 
have some directional lighting. 

•	 If you are using Radiosity, turn 
off the layer lighting. 

•	 If you want to replicate blue sky 
light, set the colour to a very pale 
blue. 

•	 You can also assign Background 
Lighting options. One of the 
cool options is to use HDRI 
Backgrounds. HDRI stands for 
High Dynamic Range Image 
(http://en.wikipedia.org/wiki/
HDRI). HDRI backgrounds are 
really effective, but they take a 
long time to render. 

Light Sources

•	 The light sources are the lights that make the rendered image come 
to life. 

	 There are 4 types of light sources that you can make with the light 
tool:

	 - Directional	  
- Point

	 - Spot
	 - Custom

http://learn.archoncad.com/?p=1540
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Textures

Textures are the things that make you drawing stand out and have a bit 
of zing. They can be created inside VectorWorks and can be created from 
digital images, or from shaders (built in mathematical descriptions of 
textures).

You should consider having an office library to store resources like 
symbols, layer and class standards and textures. It will be a lot easier for 
you to find textures that you like using in your library rather that hunting 
through all your old files.

Creating Textures 

cadmovie101

•	 Change to the Rendering layer.
•	 Open the resources palette and right 

click on an empty area of the Resource 
Brower.

•	 Choose New Resource in... > Texture. 

•	 This dialog box allows you to 
create and edit textures.

•	 Name your texture. We will 
create a wood texture, some sort 
of pine timber. 

•	 Name the timber Wood.
•	 Click on the pop-up menu for 

colour.
•	 This will open a menu for you to 

choose the type of colour. It could 
be a scanned image, or one of the 
built in shaders.

•	 Choose Pine.

•	 After you have chosen pine, you can click 
on the edit button directly below Pine, this 
opens the Edit pine dialog. Here you can 
make your texture look like real pine by 
changing the colour, grain, gnarl, etc. 

•	 Click on the OK button.

•	 Change the Size to 40mm 
(1.75”).

•	 Change the Obj Size to 50mm 
(2”), This means that the preview 
object is 50mm in size. This 
should give you a good idea of 
the grain on our object. 

•	 Click on the OK button.

This is a great way to get an idea of what the 
texture will look like on your object.

http://learn.archoncad.com/?p=1543
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Assigning Textures Directly

•	 Select the object that you want to assign 
the texture to.

•	 On the Resource Brower double click on 
your Wood texture. 

•	 To edit the texture, right mouse click on 
the Wood texture on the Resource Brower.

•	 Choose Edit from the pop-up menu.
•	 Edit the pine texture. Change the scale to 

make the texture look better. 
•	 It is important to edit the textures so that 

they look correct.

Tip: 
you can also Drag and drop textures from the Resource 
Browser onto a 3d object to assign the textures.

Assigning Textures Using Classes

If you set up your file early on to use textures for specific classes that 
you want to texture then you have an advantage when it is time to assign 
the textures. By going to the classes dialog you can then texture all the 
objects of a specific class.

•	 Create a new texture.
•	 Name it Marble.
•	 Use a Marble texture from the 

Color pop-up menu.
•	 Edit the marble so that it has 

better colours and grain.
•	 Click on the OK button.

•	 Open the classes Setup dialog, 
from the Menu Bar choose: 
Tools > Organization...

•	 Double click on the Floor class. 
•	 Set Marble and the texture for the class.
•	 Click on the OK button.

•	 If you get a dialog box asking if you want to assign the texture to all 
objects say yes always.

•	 If you use objects in VectorWorks there is often the choice to use 
classes for parts of the objects. This makes it very easy and quick to 
add textures to objects. It also makes it easy to control the textures 
in a project. 
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•	 Select the floor object. 
•	 Assign the floor object to the Floor class.

Mapping Textures 

cadmovie102

Mapping textures is the way that VectorWorks (and the other CAD 
programs) drape the textures of the objects. One of the tricks to getting a 
good render is to get the texture mapping right. The wood texture has to 
appear the right size for the rendering to look right. When we created the 
texture we set the preview on the object to be 50mm, this was to give us 
an idea of what the texture would look like on a reasonable sized object.

•	 Change to the Texture Mapping layer.
•	 This file has an object with 

textures already in it. .
•	 Open the Object Info Palette. 

•	 Click on the Tab for Render. 
•	 This is used to apply textures to 

VectorWorks objects and also allows 
you to adjust the mapping, depending 
on the way that the texture is created. 

•	 This object has a texture that can not 
be edited on the Object Info Palette. 

•	 Using the Resource Brower. Find the wood 
texture and right mouse click on it. 

•	 Choose Edit.

•	 On the Edit Texture 
dialog, change the size to 
150mm (6”). That is over 
3x bigger than it was. 

•	 This will cause the texture 
to look too big.

•	 Click on the OK button.

•	 You can now see the size of the 
texture that we created is not suitable 
for our timber block, , although it 
may be great for a far away view.

Often you need to exaggerate textures to get 
them to read correctly in a rendered image.

http://learn.archoncad.com/?p=1546
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Texture From Image

Creating a texture from an image allows you to make any texture that you 
want. You can scan an object, a logo, you can use a digital photo or you 
can make up an image in Photoshop.

cadmovie103

•	 Right click on the Resources Browser.
•	 Choose   New Resource in... > 

RenderWorks Texture...
•	 To create an texture from an image you 

need to create the image. I have already 
made one for you in this file.

•	 On the texture Dialog 
Box choose Image Color 
from the pop-up where it 
says Color. When you 
choose this from the 
pop-up, VectorWorks 
wants to know which file 
to import. 

•	 Reuse an image from another resource. Click on the pop-up menu 
and choose Stucco image. 

•	 Click on the OK button.

•	 Tile image horizontally and vertically, 
otherwise your texture will be a small 
square in the middle. 

•	 When you choose Filtered Image, you can 
choose a filter colour for the image. This 
allows you to duplicate this texture and 
change the filter colour to make a different 
texture. 

•	 Click on the OK button.

•	 Click on the Bump pop-up menu.
•	 Choose image bump.
•	 Reuse an image from another resource. 

Click on the pop-up menu and choose 
bump. 

•	 Click on the OK button.

•	 The softness controls how the bumps 
appear, with soft edges, or with sharp edges. 
To get real control over the transition from 
the base texture to the bump, make sure 
that you have soft edges on your image.

•	 This is the image with 
the bump. You can also 
control the size of the 
texture.

http://learn.archoncad.com/?p=1557
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•	 Change the size to 50mm 
(2”). 

•	 Change the Obj Size (the 
preview) to 50mm (2”). 
This allows you to see 
more accurately how the 
texture will look on the 
object.

•	 Click on the OK button.

•	 Apply this texture to 
your object and render 
the view in Final Quality 
RenderWorks.

Making an Image Prop

cadmovie104

An image prop is where you take an image file and convert it into a 3D 
object in VectorWorks. The image file could be a photograph of a tree, 
a person, or even a sketch that has been scanned. In your exercise file 
I have scanned a couple of hand-drawn images for use to make image 
props from.

•	 First, you have to draw and scan your 
image. I drew this image with a thick 
felt-tip pen. Then I scanned the image 
as a black and white image at 300dpi. 

•	 Open the image in Photoshop and add 
the red colour to it. You don’t have to use 
Photoshop, any image editing program 
should be able to do this for you. 

•	 The red colour is the main trick. I’m going 
to use the red colour to refine the area that 
will be transparent. If you don’t add a solid 
colour like this, you will find it imposssible 
to make the image prop correctly. 

•	 You will find that I have already imported 
this as an image in the exercise file. 

•	 Go to the Menu Bar.
•	 Choose 

Model > Create Image Prop...

http://learn.archoncad.com/?p=1559


©Jonathan Pickup	 cadsupportonline  - Issue 0711

Page 17

•	 Choose to Reuse an Image 
From Another Resource:

•	 Choose fred-2. When you make 
your own images, you will have to 
import an image file at this point. 

•	 Fill in the height of the image prop. 
VectorWorks then fills in the correct 
width for you. If you change the 
width, the height will automatically 
change if you lock the aspect ratio.

•	 Chose the option for Use Mask. 
•	 Choose the other options that 

you want. I have chosen the 
options that I use most often. 

•	 Click on the Create Mask... button. 
This is where you choose the red 
colour as the transparent background. 

•	 Choose to Reuse an Image 
From Another Resource:

•	 Choose fred-2. 



©Jonathan Pickup	 cadsupportonline  - Issue 0711

Page 18

•	 Choose Transparent Color.

•	 This dialog box is where you 
choose the transparent colour.

•	 Click on the red colour. 
VectorWorks will the 
colour as the mask.

•	 The sliders can be used to adjust 
the mask and the mask contrast. 
These settings will make the 
image props slightly see-through. 

•	 Click on the OK button. 

•	 Check the options again.
•	 Name your image prop so that 

you can find it easily. 
•	 Click on the OK Button. 

•	 VectorWorks places 
your image prop in 
the middle of the 
drawing. Notice that 
the image prop is 
slightly transparent. 
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•	 If you want the place more image 
props, you can select them from the 
Resource Browser. They appear in 
the Resource Browser as a symbol.

•	 I have included another 
sketched person.

•	 and  tree or two. 
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Q u e s t i o n s  a n d  A n s w e r s

Q.  “How can I use an iPod as a presentation device? ”

If you are only going to use your iPod as a presentation device, not for 
backup and storage, then you can use any of the iPods except for the 
shuffle. So, you could buy a Nano 4GB or an iPhone and use it for presen-
tation.

Step 1

Create the presentation you want. This can be photos or a movie. Using 
an iPod for presentation is not like a keynote or PowerPoint presenta-
tion. It can be a slide show or a series of movies, but it will not look 
slick if fumble about on your iPod looking for photos then a movie. On 
a Macintosh it is easy to turn your photos into a slideshow, so you could 
haave a series of movies to show your clients. 

Step 2

Tell your iPod to syncronise your photos and movies. When you do this 
your iPod will copy the movies and photo files from your computer and it 
will put the photos and movies in separate areas of the iPod. 

Step 3

Connect the iPod to a TV. On the Apple web site you can purchase two 
types of connectors; component video and composite video. Component 
video will be the new standard, that is, all the big new TV’s have compo-
nent video, but nearly all TV’s have composite video (even 10 year old 
TV’s). Component video is higher quality, but composite video is more 
universal. 

Step 4

Set the TV to the correct video input and play the iPod. 

Q.  “Can I Re-use My VW12 Wall Sytle Library in VW2008? ”

The answer is yes and no. You could re-use your old wall style library 
in VectorWorks 2008, but you will miss out on the new wall component 
abilities. It would be better to edit all the old wall styles to take advantage 
of the classes on the wall components. 


